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Introduction 
You demand fast and accurate document comparisons, and now you can have it.  

'Diff Doc' is a powerful yet easy to use file comparison and remediation utility.  

Use it to compare PDF, MS Word/Excel/PowerPoint, RTF, Text, XML and 

HTML documents.  Whole folder comparisons can also be done saving you the 

time of manually doing each file compare. 

Regardless of the editor you are using (MS Word, Wordpad, Excel etc), simply 

load the original and modified files, press the refresh  button (  or F5), and the 

visual differences will display promptly.  Navigate through each of the 

differences easily and generate reports in a variety of formats (DOC, HTML 

etc.). 

Of course there are several options and features that need to be discussed so that 

you can fully leverage all of 'Diff Doc's capabilities.  This manual serves this 

purpose and can be read in whatever order you desire.  We first discuss file 

comparison, then folder comparison and then move to finding textual content 

with files.  More advanced topics like using the application from the command 

line are towards the end of the documentation. 

At SoftInterface, Inc. we are constantly enhancing and improving our products.  

Please visit our web site to see what’s new and tell us what you would like to see 

in our products (www.Softinterface.com). 

 

http://www.softinterface.com/
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'Diff Doc' Features 
 Compare MS Word/Excel/PowerPoint, PDF, WordPerfect, Rich Text (RTF), 

Text, XML or HTML 

 Compare Any file type against Any file type (i.e. An MS Word compared 

against a WordPerfect document) 

 Navigate easily through the differences with the Next (F7), Previous 

(Shift+F7) etc. navigation buttons.  Or use the drop down list box to jump to 

a specific difference. 

 Both Side By Side and All In One views are supported 

 Integrated into the Explorer Shell (Windows Explorer, Desktop, Find in 

Files, etc.) for quick comparisons. Use right mouse click. 

 Compares any text from any application 

 Paragraph differences are highly detailed 

 Colors and formatting used to highlight the document can be customized 

 Create reports in several formats and file types (DOC, HTM, TXT etc). 

Detailed Word and HTML Reports now possible allowing for printing and 

e-mailing results quickly. 

 Fonts, and formatting to remain intact while comparing documents 

 Run it from the Command Line allowing for automation 

 Can be adapted for all languages (i.e. German, Japanese etc.) 

 Currently compatible with WORLDOX 

 

 





 

5 

Comparing Files 
Comparing Files Quick Start 

There are 3 main tabs within the 'Compare Files' form, " Compare Files", "  

Compare Options" and "  Report Options".  Each tab is discussed in the 

chapters that follow.   However, if you need to compare documents quickly 

follow the directions below: 

1. From the File Menu, select "Compare Files" or CTRL-F 

2. Select the Original File using the "  Original" button. 

3. Select the Modified File using the "  Modified" button. 

4. Press the F5 or   Button to Refresh the difference viewer. 

5. You can abort the refresh process by pressing the Abort button on the 

toolbar . 

6. Press   on the toolbar or F2  to create Report (only after Difference 

Viewer has been updated). 

7. See the following chapters for more information on navigating 

differences and the colors used in the reports. 

 

See Appendix C for information on using the Explorer Shell context menu. 

Comparing Files 

Compare Files 

Comparing files is the primary feature of  'Diff Doc'.  You can open the 'Compare Files' form by pressing 
CTRL-F or from the File menu, select 'Compare Files'.  Below is the main screen used while doing file 

comparisons.  There are 3 main tabs within the 'Compare Files' form, "  Compare Files", "  

Compare Options" and "  Report Options".  Each tab is discussed below. 
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Legend Use 

1 
Upper Tool Bar  

Refresh Difference Viewer (reloads files if necessary and highlights changes found) 

 Generate Report  

 Swap original and modified files  

 Find Text  

 Options specific to the file type being compared  

 

'Side by Side' to 'All In One' view toggle button  

 

 Mail Report  

Navigate differences (  Last, Next, Previous, First, Specify) 

 

2  
Lower Tool Bar 

 File Selection,  re-load file and launch file in default editor   

 

3  
Editor Windows 

Load textual content to compare, F8 toggles these to visible and hidden 

 

4 
Difference Viewer  

After comparison is completed, the red lined content appears here 

 

5 
Summary Buttons  

See everything or only the additions, changes, or deletions.  

It is within the 'Compare Files' tab that you will spend most of your time.  There are 3 or at most 4 editor 
boxes displayed at any time.  The top two editors are referred to as the "Original editor" and "Modified 
editor".   If desired, these editors may be toggled between visible and invisible by pressing F8.   Also, 
you can compare any section of text between to the top two editors.  The text editors below are referred 
to as the "Diff Viewers".  It is within the Diff Viewers that the changes between the Original and Modified 
editors are updated and displayed. 

The first step in comparing is to load both the "  Original" and "  Modified"  editors either by opening 
previously saved files, copying and pasting data, or composing new text.  Use the File menu to load 
previously saved files, or position the mouse over the editor you wish to load and click the right mouse 
to display a context menu.  Select Load File Into This Editor.  Copying and pasting is done differently 
for different programs.  However, in most cases, simply highlighting the text, and pressing CTRL-C will 
copy.   To paste, simply click on the Original or Modified editor, and press CTRL-V.   

Note: if you are pasting or composing text within the Original or Modified 

editors, be sure to go to the ‘Compare Options’ and select ‘Do not reload files’ in 

the Refresh Options.  Otherwise when you press the Refresh button the last 

selected files will be loaded, overwriting whatever was in the editors. 

Next press the "Refresh Diff Viewer" button  (or F5).  The differences between the Original and 
Modified editor boxes will be displayed in the Diff Viewer.  You can abort the refresh process by 

pressing the abort button on the toolbar .  
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Default 
Color 

Meaning 

Red Change has occurred.  Original text is shown in red, 
bold, with a strike through, whereas Modified text is 
shown in red, bold with an underline. 

Green An addition to the Original document has occurred.  
It is shown bolded in green. 

Blue A deletion from the Original document has occurred.  
It is shown bolded in blue with a strike through. 

Diff Viewer Legend 

 

Comparing Selected Text Within the Original And Modified Documents 

Comparing selected text within the Original and Modified editors is a very 

powerful tool for overcoming any alignment issues, or simply comparing content 

in different sections of your file.   

NOTE: To "select text" simply click the mouse down, and (while the mouse 

button is down) drag the mouse to the portion of text you are interested in, finally 

unclick the mouse. 

Normally a file comparison is done by loading and/or reloading the Modified and 

Original editors. Once the text is in these editors you can select any portion of 

each, right mouse click (or from the "View" menu), then choose "Compare 

Selected Text".  A new window will open containing the contents of the selected 

items, and the difference viewer will automatically refresh.  

Note that the Compare Options of the newly opened window may be different 

than the original one.  In particular the Refresh option. 

 Create Reports (F2) 

A report is created by clicking the report button on the toolbar, pressing F2, or by 

selecting Report from the View menu.  The report, which opens in a separate 

window, is based on criteria specified in the "  Report Options" tab, further 

described below. 

You can also print or save any of the editors or viewers by using the right mouse 

button; or, alternatively you can select the editor or viewer with the left mouse 

and then print or save from the File menu. 

NOTE: Saving as MS Word, or HTML requires that MS Word be installed on 

your PC. 

 Swap The Original and Modified Files(F9) 

The Swap button (or F9) will swap the contents of the Original and Modified 

editors and then automatically refresh the Difference Viewer.  If "Reload 

Selected Files…" is selected from the Compare Options tab, the files are 

reloaded.  Otherwise, only the text is swapped. 

 Find and Replace (F3) 

Find and Replace button can be used to seek out text with any of the editors or 

viewers.  Click the editor or viewer you want then press F3 to begin searching. 

Toggle between Views (F6) 
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The largest button within the toolbar will alternate the Difference Viewer 

between the "All In One" and "Side By Side" views.  Typically, those dealing 

with literary content will like the "All In One" view, whereas programmers 

dealing with source code will like the "Side By Side" view for easy line-by-line 

comparison.  Alternating between views also gives you a feel for how the red-

lining really works. 

Another display option is Word Wrap from the View menu.  If Word Wrap is on, 

the file will display the width of the viewable area in a window without the need 

to scroll horizontally.  If Word Wrap is off, the file will display each line 

uninterrupted by carriage returns . 

Navigation of the Differences Found (F7, Shift-F7…) 

Once the difference view has been refreshed, and at least one difference has been 

found the navigation toolbar/keys may be used.  The table below shows the 

available commands: 

Button Purpose 

  F7 Jump to next difference 

  Shift-F7 Jump to previous  difference. 

 CTRL-F7 Jump to last difference 

  Ctrl-Shift-F7 Jump to first difference 

 F4 Jump to difference [number] that you specify 

There is also a drop down listbox at the right end in the upper toolbar, which 

displays a difference with some identifying text that can be used for navigation.  

Selecting an item will take you to its location. 

Toggle Editor Windows On or Off (F8) 

Clicking F8 will act like a toggle to close or open the upper editor windows.  

When editors are closed, the Difference Viewer(s) will occupy the entire viewing 

area.  All Windows are also resizable by simply dragging them to the desired 

size. 

Vertical and Horizontal Scroll Lock (F11 and Shift+F11) 

If you need to adjust the vertical or horizontal scrolling of the windows you can 

lock or unlock easily.   Press F11 to toggle the vertical scroll lock.  Press 

Shift+F11 to toggle the horizontal scroll lock. 

 Reload Selected Files 

Select a file from the drop down list or type a file name directly into the listbox 

and load it by clicking this button.  This is a useful timesaver when switching 

between multiple files. 

  Open Selected File in Default Application 

Opens a file in a separate window in its native application, based upon the file’s 

extension, e.g., .doc opens in MS Word, .xls opens in Excel, .rtf or .txt open in 

Notepad.  

 Paragraph Scroller  

Found in the center of the Lower Toolbar.  Click on either control arrow to 

concurrently move the text in all editor windows paragraph by paragraph.  Place 
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the mouse over the center of the Paragraph Scroller until you see a double sided 

arrow then drag to rapidly scroll all windows simultaneously.   

 Summary Buttons 

Directly above the Windows status bar on the ‘Diff Doc’ status bar are four 

buttons that can individually summarize and display each type of change 

detected within the Diff Viewer.  These are populated with meaningful contents 

only after a comparison has completed successfully. 

Button Purpose 

      Shows all differences detected within Diff Viewer 

      Shows only additions within Diff Viewer 

      Shows only deletions within Diff Viewer 

      Shows only changes within Diff Viewer 

 

 Printing and  E-Mailing Reports 

Once the report is created it is available in an appropriate application.  HTML 

Reports are shown in a browser, which typically has the ability to save, print and 

e-mail from the File menu.  Other reports may show up in Notepad or MS Word, 

which can be printed, e-mailed, edited or saved from there. 

Compare Options 

General 

 Compare Options 

General Options 

The "  Compare Options" tab has the items shown below: 

 

Setting Description 

Ignore Case Ignore character case differences. 

Ignore White Space Ignore white space characters (Horizontal Tab, 

Vertical Tab, New Line, Form Feed, Carriage 

Return, and Space). 

Ignore Empty Lines Ignore lines that are completely empty.  White 

space characters alone will make a line not empty. 

Beep When Done When set, a system beep will occur when the 

comparison has completed. 

Load last worked on files 

at start of application 

Re-load files you were working on when last 

exiting the program. 

 

Refresh Options 

When pressing the F5 or  button the Diff View is updated.  At this time the 

selected files can optionally be re-loaded into the Original and Modified editors 

before the comparison, or the text already in these editors will simply be 

reviewed for recent changes. 
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Printing Options 

The margins can be specified here for all sides of the page, of all the editors in 

this form.  Better printing results from creating an MS Word style report, and 

opening and printing the report in MS Word.  For example the underline 

becomes a double underline within MS Word. 

Word File Options 

Specify passwords that may be required to open the Original or Modified file. 

Additional options for specifying pages will be included eventually. 

Excel File Options 

Specify worksheets, rows and columns to be compared and whether or not 

formulas are to be compared. 

You can specify to put the sheet name above the data corresponding to that sheet. 

This can be helpful if you are comparing more than one sheet at a time.  

Narrowing what you compare leads to quicker and concise reports.  Also an 

option is adding a new line character which is good for printing reports. 

You may want to pad the data with spaces, if so, use the largest number that you 

anticipate a column/field having. 

Quick Excel Data Extraction will use Softinterface’s internal methods for getting 

the data from an Excel file. This is quicker than using Excel, and is extremely 

useful if you don’t have Excel. 

Lastly, you can specify passwords to open the Excel files if required. 

PowerPoint File Options 

You can optionally include Slide and Shape Number to the content being 

compared. It is recommended you do so, as the comparison results are better 

understood, and highlighted better. 

Notes from within each slide can optionally be included in the comparison. 

You can also specify which slides you want to compare.  Narrowing what you 

compare leads to quicker and concise reports. 

HTML/XML File Options 

In order to compare HTML source scripts, this item should be selected.  

PDF File Options 

Depending on how the PDF file was created, it may be necessary to experiment 

with the options to see what gives you the optimal results.  When converting 

from PDF to RTF/DOC the following advanced options are available by pressing 

the Advanced Options button.  These options are not available for Text or 

HTML formatted files. 

 

Option Meaning 

Adjust Font Names Select this option to use the fonts that have been 

installed on your PC.  This may enhance the 

accuracy of the resulting RTF file.  

Adjust Spacing Only available with the Use Textboxes for Exact 

Placement option.  Adjusts spacing according to 

the PDF spacing. 

Conversion Method There are three options for conversion method.  

Choose each based on input format and the desired 

output.  See Document Layout for more 

information on format of input document. 
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Preserve Layout Using Spacing and Tabs – 

available for single column documents only.  

Positioning of text within the resulting document 

will preserve the layout of the original using tabs 

and spaces instead of textboxes.  See also the 

Detect Header option. 

 

Use Textboxes for Exact Placement – resulting 

text maintains the same positions as the original 

through the use of textboxes.  See also Merge Text 

and Adjust Spacing options. 

 

Text Flow – extracts text and graphics from the 

document but without maintaining the original 

layout.  Available for single or multiple column 

documents, editing may be easier if Text Flow is 

selected. 

Detect Header Available only with conversion option Preserve 

Layout Using Spacing and Tabs.  When selected 

Convert Doc will automatically detect the header 

and footer in a document. 

Document Layout There are three possible types: 

 

Single-column – use for simple documents that 

don’t contain columns. 

 

Multi-column – for use with complex documents 

that may contain columns.  Select the Text Flow 

method for this document type. 

 

 Pleading – specifically for use with documents in 

a legal pleading format.  To edit the line numbers 

in the resulting RTF document, select "View-> 

Header and Footer" in MS Word.   

Extract Hyperlinks Choose this option to retain the hyperlinks of the 

original document. 

Extract Images This checkbox is found under the "Images" tab.  

You can optionally have images from the original 

PDF included in the RTF file that is created.  

Check this option to include the images from the 

original PDF file.  Images may be saved in either 

JPG or BMP format. 

 

Not checking this option will exclude all images 

from being added to the resulting RTF file.  Note, 

some images may include textual content in them. 

From Page Found under the "Specify Pages" tab, this option is 

only available if the Specify Pages to Convert 

option is selected.  Indicates the first page of a 

range to be converted. 

Image Format Found under the "Images" tab, select JPG or BMP.  

JPG is the default. 

Include Text You may optionally have text from the original 

PDF included in the RTF file that is created. 

 

Check this option to include the text from the 

original PDF file.   
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Not checking this option will exclude all text from 

being added to the resulting RTF file.  This does 

not however, exclude images, that may or may not 

have text in them. 

Merge Paragraph Select this option to place multiple lines of text 

into paragraphs. This will make editing easier, but 

may, under certain circumstances cause the 

document to look different from the original. This 

is due to font incompatibilities between PDF and 

RTF. 

 

If the option Use Textboxes for Exact Placement 

is being utilized, the Merge Text option should 

also be selected. 

Merge Text Select this option to merge individual words into 

lines of text.   

 

Not selecting this option will result in each word 

being placed into individual text boxes.  This 

preserves textual position from the original 

document more accurately. 

Owner Password Owner password(s) for encrypted files.  Use a 

comma to separate multiple passwords. 

Shrink Fonts Selecting this option will ensure that all text fits 

within its original area on your screen. This is 

useful if the extracted text is lengthy. The option 

automatically alters font size to fit within the text 

boxes of your RTF documents.  Only available 

with the Use Textboxes for Exact Placement 

option.   

Specify Pages to Convert Found under the "Specify Pages" tab.  If this 

option is selected you may indicate a range of 

pages to be converted. 

To Page Found under the "Specify Pages" tab, this option is 

only available if the Specify Pages to Convert 

option is selected.  Indicates the final page of a 

range of pages being converted. 

User Password User password(s) for encrypted files. Use a comma 

to separate multiple passwords. 

 

 

View 

View Options 

These options control how changes, additions or deletions will appear in the Diff 

Viewer.  Font color, background color, underline, strike out, bold and italic can 

all be set as desired. 

Difference Viewer Selection:  When navigating from one difference to the next, 

you can optionally have the Diff Viewer completely select the paragraph that has 

been changed.  The Original and Modified viewers are automatically highlighted. 

 

Report Options 
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 Report Options 

The report created is dependent on the settings in the "  Report Options" tab.  

One of the 4 file types, HTML, Text, Comma Delimited or MS Word, is chosen 

here.    Further, each file type has a separate tab where you can choose to modify 

the default name and path for the report being created.   

For MS Word reports you can specify whether all differences are reported or 

additions, deletions or changes only.   

HTML reports allow you to temporarily override the names of the original and 

modified documents by specifying alternate names in "Original Column Title" 

and "Modified Column Title".  HTML reports have an additional option of 

specifying either "All In One" or "Side By Side" view. 

Of course you can also print any of the editors from the File menu.   However 

you’ll get much better results by printing an MS Word report than printing the 

difference viewer direction from within ‘Diff Doc’. 
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Comparing Folders 
Comparing Folders Quick Start 

Use Compare Folders to get a bird’s eye view of the current contents of folders.  

See what files are in each folder and whether or not those files have changed 

relative to one another.  You can compare folders by Date, Size and Content.  

Open a 'Compare Folder' form by pressing CTRL-D or select File / 'Compare 

Folders' from the main menu. 

There are 3 main tabs within the 'Compare Folder Form';  " Compare Folder", 

" Compare Options" and  "  Report Options".  Each tab is discussed in detail 

in the chapters that follow.  To quickly begin comparing folders follow the 

following steps: 

 

1. From the File menu, select "Compare Folders" or CTRL-D 

2. Select the Original Folder using the "  Original"  button. 

3. Select the Modified Folder using the "  Modified"  button. 

4. Check the 'Compare Options' tab to ensure your compare criteria are 

appropriate (see below for more details). 

5. Press F5 or the  Button to Refresh the difference viewer. 

6. You can abort the refresh process by pressing the ESC key or the Abort 

button  on the toolbar. 

7. Quickly compare files within the folders by double clicking changed files 

(highlighted in red).   

 

 

See Appendix C for information on using the Explorer Shell context menu. 

 

Comparing Folders In Detail 

Compare Folders 

 

Note:  To compare files within the folders, double click any of the red results 

listed.  The file comparison screen opens in a separate window.  
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On the toolbar you will find the "Refresh" button .   Pressing this will start the 

folder comparison using the currently selected options.  Pressing F5 has the same 

effect.   

To the right of the refresh button is the 'Create Report' button .  Click this to 

launch a report of the results shown.  Reports may also be created by pressing the 

F2 button. 

If you want to quickly swap the Original and Modified folders you can do so by 

pressing the  button on the toolbar or press F9.  The difference viewer 

refreshes automatically. 

The file type’s drop down list box allows you to specify what file type(s) you are 

interested in comparing.  If left blank all file types (*.*) will be compared.  You 

can compare multiple file types by specifying each with a space separating them.  

For example, to compare all TXT and DOC files use "*.TXT  *.DOC". 

The legend at the bottom explains what the color coding means.  It can be hidden 

or shown by selecting Show Legend from the View menu item on the main 

menu. 

When the contents of a file have changed, it is shown in red, and it's contents 

property is flagged with the "CHANGED" key word.  If the size has changed the 

Size property details which file is bigger.  For example "[O] >[M]" indicates that 

the original file is larger than the modified file.  The same applies for date.  If the 

Modified file is newer, it is said to have a larger date and therefore "[M]>[O]" 

will be displayed the Date property. 

You can select individual files from the difference viewer and by clicking the 

right mouse button either delete or copy the files. 

 

Compare Options 

The options associated with the folder comparison are detailed below: 

Setting Description 

Show Files that are only in the 

ORIGINAL Folder 

Those items that exist in the Original folder 

but not in the Modified folder will be 

displayed 

Show Files that are only in the 

MODIFIED Folder 

Those items that exist in the Modified folder 

but not in the Original folder will be displayed 

Compare File Contents If a file exists in both the ORIGINAL and 

MODIFIED folders, file contents will be 

compared and results displayed.  See also 

"Show files whose CONTENT are SAME/ 

DIFFERENT" 

 

Show Files whose CONTENT 

are the SAME in both places 

Display those similarly named items whose 

content is the same. Comparison criteria 

include file size, file contents and, optionally, 

file date. 

Show Files whose CONTENT 

are DIFFERENT 

Display those similarly named items whose 

content is different. Comparison criteria 

include file size, file contents and, optionally, 

file date. 
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Ignore Date Differences Exclude date as one of the 3 criteria for file 

comparison (content and size remain active 

criteria). 

Look in SubFolders Compares the files within subfolders. 

 

Show All Findings At END of 

search 

Select this to increase the speed of the 

comparison.  If not checked the program fills 

in the results as it receives them.  This may be 

desirable, as you may still use the program 

while a folder comparison is in progress. 

Beep When Done When selected  'Diff Doc' beeps to notify you 

that the folder comparison is complete 

 

 Report Options 

Here you can specify what the name and folder of the tab delimited report file 

will be.  You can open this file in MS Excel or notepad for viewing purposes. 
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Finding Text In Files 

 Finding Text In Files 

Finding text in documents across folders and file types can be very useful.  To 

find text in files press CTRL-I or select "Find Text In Files" from the File menu.  

Once the search has begun you may stop it by pressing ESC or the abort button 

 in the toolbar. There are 3 main tabs within the 'Find Text' form, "  Find 

Text", "  Find Options" and "  Report Options".  Each tab is discussed in 

detail in the chapters that follow. 

 

 

 Find Text 

To find text simply follow these steps: 

1. Type the string to search for in the "What to find" drop down list box. 

2. Enter the file types you are interested in within the "In Files/File Types" 

drop down list box, preceded by an asterisk .  Separate multiple types with a 

comma (e.g. *.doc, *.xls, .*.htm). 

3. Select the folder you want to conduct the search in within the "In Folder" 

drop down list box. 

4. Choose any search options within the "Find Options" tab 

5. Press F5 or Refresh button to initiate the search. 

To create and/or print a report of the items found, select Report from the View 

menu or press the "View Report"  button on the toolbar (F2 also creates the 

report). 

On the toolbar you will find the "Refresh" button .  Pressing this will restart 

the text search using the last set options.  Pressing F5 has the same effect.  To 

abort a search press ESC or the abort button  in the toolbar. 
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 Find Options 

The options associated with finding text are shown below: 

Setting Description 

Beep When Done Select to have a beep notify you search has 

completed. 

Case Sensitive When Selected: Finds all occurrences with the 

exact combination of uppercase and lowercase 

letters specified in the SearchString property.  

When NOT Selected: Finds all occurrences of 

the string specified in the SearchString 

property ignoring  the case of individual 

characters. 

Look In Subfolders Select to have the search extend to all 

directories under the specified SearchPath. 

Regular Expression Select to have the search engine use regular 

expressions detailed in the "Search For" string.  

Regular expressions are illustrated below 

Show All Findings at end of 

search 

When selected all results will be shown upon 

search completion, otherwise the results are 

displayed as they are found.  Displaying at the 

end produces a faster overall search time. 

Support MS Word and Excel To be able to search within these binary files 

for text, select this option. 

Whole Word Only When selected: Searches for the full word by 

itself and not as part of a larger word.  When 

NOT selected:  Searches for the SearchString 

regardless of it’s neighboring text. 

 

Supported Regular Expression Symbols 

Key characters/symbols are parsed by the search engine to accommodate the 

search.  Regular expression symbols are easily accessed using the  button to 

the right of the "Find What" drop down list box.  The following key characters 

are supported: 

KEY MEANING USAGE 

? Match any or no 'single 

character'. 

To find all cases where the characters 

'v' and 's' have zero or one character 

between them use: 

"v?s"   

Possible hits ("vis", v_s", "vs", etc.) 

* Match any or no string of 

characters 

To find all cases where a word or 

phrase ends in "sion" use: 

"*sion" 

Possible hits ("passion", "vision") 

[ ] Match any single character 

included between the brackets. 

To find all "visib" and "visio" use: 

"visi[b,o]" 
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Possible hits ("visibly", "vision") 

\ Literal character to match the 

character immediately following 

the backslash. 

To find all instances of the word 

"visibly" where the last letter is capital 

use: 

"visibl\Y" 

Possible hits ("visiblY","VisiblY") 

assuming not case sensitive 

^ Match must be at the beginning 

of  the string. 

This character must be the first 

character in the regular expression. 

"^PleaseBeFirst" 

Possible hits ("PleaseBeFirst ok?")  

$ Match must be at the end of the 

string. 

This character must be the last character 

in the regular expression. 

"^PleaseBeLast$" 

Possible hits ("Ok now PleaseBeLast")  

 

 Report Options 

Here you can specify what the name and folder of the tab delimited report file 

will be.  You can open this file in MS Excel or notepad for viewing purposes. 
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Switching or Adding A Language 
Switching or Adding A Language 

'Diff Doc' allows for the selection of language by using the View\Language 

menu item.  From here you can select any of the languages available.  You must 

restart the program for the language setting to take effect. 

Adding or modifying a language is as simple as editing a Language File and 

placing it in the Languages Folder.  The Languages Folder is located at the 

installation folder and is usually: 

C:\Program Files\Softinterface, Inc\DiffDoc\Languages\ 

Typical Language File names are shown below: 

      Japanese-'Diff Doc'.txt 

      German-'Diff Doc'.txt 

Notice that the name of the file is very important, because 'Diff Doc' looks at all 

file names in the Languages Folder to build its available Language File listing.  

The Language File name has the following format: 

     Language-'DiffDoc'.txt 

So to add a language, copy an existing language file, rename it, the edit it. 

The Language File has the following format: 

"English Word","Trlansation of EnglishWord" 

"Ok","Si" 

"Without","Sin" 

. 

. 

There cannot be any spaces between the English and Translated versions.  That is 

the following will not work: 

"English Word" , "Translation of English Word" 

"Ok" ,"Si" 

"Without", "Sin" 

If you would like to contribute to the growing Language File archive and 

possibly receive free license(s) please see: 

http://www.softinterface.com/MD/MD_Languages.htm 

We also appreciate any corrections you may have to the existing Language Files. 

 

http://www.softinterface.com/MD/MD_Languages.htm
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Updated Information 
Updated Information 

If you encounter problems your first troubleshooting steps should be to: 

1. Review this manual. 

2. Check the SoftInterface Web site for updates, help information, FAQs and 

suggestions  

http://www.softinterface.com/md/md_faq.htm 

We keep the FAQs updated with latest bug fixes and revision information.  

Find your product and check the FAQs page. 

3. E-Mail questions to Support@SoftInterface.COM 

We hope that ‘Diff Doc’ ease of use and this documentation will provide all the 

help you need. 

 

http://www.softinterface.com/md/md_faq.htm
mailto:Support@SoftInterface.COM
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Using the Command Line Interface 
Using the Command Line Interface 

See  also: 

 Command Line Examples – General  

Command Line Examples - Excel  

'Diff Doc' can be run from command line arguments much like in the good old 

DOS days.  Alternatively you can create a command line execution by going to 

the Windows START-RUN menu and typing it in there.  The syntax for the 

command line is: 

 

DiffDoc /M{Original File} /S{Modfiied File} [/I] [/W] [/Q] [/A] [/B] [/E] [/H] 

[/X] [/Y#] [/Z#] [/1 - 4]  [/7 - 9]  [/T{ReportFile}] [/R#] [/F#] [/L{Log File}] 

[/V] [/O] [/D] [/C] [/K] [/P] [/N] 

 

Items above enclosed in square brackets "[ ]" are optional, all other ‘switches’ 

are required.  Therefore /M, /S, should always be specified on the command line.   

 

You can include or exclude spaces between switches and parameters.  For 

example,  "/R1" is the same as "/R  1".  For long file names you may be required 

to use double quotes.  For example /S"C:\Program Files\MyApp\MyDoc.DOC". 

IMPORTANT: To use the command line successfully the operating system will 

need to know where exactly the application is located. Otherwise, you'll see the 

following error: 

“DiffDoc” is not recognized as an internal or external command, operable 

program or batch file." 

We suggest you do one of the following: 

A) Set the path in your operating system’s environment variables to the 

installation location of DiffDoc.EXE.  See your operating system’s help 

for setting the path. 

B) Create a batch file (a text file whose file name ends in .bat)  that uses the 

fully qualified path of DiffDoc.EXE. 

For example the following is a typical batch file: 

“C:\Program Files\Softinterface, Inc\DiffDoc\DiffDoc.EXE” 

/S”C:\FilesNew\A.DOC" /M”C:\FilesNew\A.DOC” /V 

You may also be able to do something like this in a batch file: 

set DiffDoc ="C:\Clients Work In Progress\SII\X\ DiffDoc\DiffDoc.EXE” 

DiffDoc /S”C:\FilesNew\A.DOC" /M”C:\FilesNew\A.DOC” /V  

One more possibility is to simply change the active folder before calling the 

application: 

CD C:\Program Files\Softinterface, Inc\DiffDoc 

DiffDoc /S”C:\FilesNew\A.DOC" /M”C:\FilesNew\A.DOC” /V  

Also, it is suggested you us fully qualified paths for any files you specify.   

 

Full descriptions for each switch is shown below, they are ordered from most to 

least frequently used: 

 

Switch Meaning 

/M{Original File} The Modified file is compared against the Original file.  See 

/S{Modified File} 

/S{Modified File} Modified file is compare against the Original.  See /M 
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/I Ignore case when comparing files 

/W Ignore whitespace characters (tabs, spaces, etc.) when 

comparing files 

/E Ignore empty lines 

/P Remove empty lines 

/N Remove formatting 

/B Beep when finished doing a file compare 

/X Exit application when done 

/Q Do a Quick file compare when comparing files 

/L{Log File} To specify  a log file to log the success or failure of the 

comparison, use this switch. 

/V Verbose mode.  Use this switch to have message box prompt the 

status of the comparison. 

 

/T{Report File} If you are going to create a report file, this switch must be used 

and the file name of the output target file must be supplied. 

/R# Report Format: 1 = HTML, 2 = Text, 3 = CSV, 4=MS Word.   

Defaults to HTML.  NOTE Only the HTML Format supports the 

Side By Side view /F2 

/F# Report Style: 1 = All In One, 2 = Side by Side.  Defaults to Side 

By Side. NOTE Only the HTML Format supports the Side By 

Side view /F2 

/O O for Open report when done.  Notepad or Internet Explorer is 

launched depending on the Report type. 

/K Do NOT create a report if there were 0 differences found. 

 

/Y# Excel, Original sheet number to compare.  Defaults to 1 

/Z# Excel, Modified sheet number to compare.  Defaults to 1 

/A Excel, Compare formulas in Excel files 

/1 Excel, Select what rows of the Master file to compare.. The 

syntax is: "1,5-10,20" where commas and dashes indicate single 

and whole sections of sheets.  Use the "*" to compare all rows.  

Defaults to all. 

/2 Excel, Select what columns of the Original file to compare.. The 

syntax is: "1,5-10,20" where commas and dashes indicate single 

and whole sections of sheets.  Use the "*" to compare all 

columns.  Defaults to all. 

/3 Excel, Select what rows of the Modified file to compare.. The 

syntax is: "1,5-10,20" where commas and dashes indicate single 

and whole sections of sheets.  Use the "*" to compare all rows.  

Defaults to all. 

/4 Excel, Select what columns of the Modified file to compare.. 

The syntax is: "1,5-10,20" where commas and dashes indicate 

single and whole sections of sheets.  Use the "*"  to compare all 

columns.  Defaults to all. 

/5 Report Original File Column Title.  Applies only to an HTML-

style reports. 

/6 Report Modified File Column Title.  Applies only to an HTML-

style reports. 

/7 Report title.  Applies only to an HTML-style reports. 

/8 User password.  Applies only to  PDF files.  Note that you may 

password one or both files being compared but if it is both they 

must share the same password. 

/9 Owner password.  Applies only to  PDF files.  Note that you 

may password one or both files being compared but if it is both 
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they must share the same password. 

 

/H HTML compare source not textual content 

  

/D Compare Folders (Directories).  See /C switch also. 

/C Compare Subfolders.  Only valid when /D switch is used. 

  

/? This information shows up 

/WPOO{Password} 

/WPOM{Password} 
WPOO = MS Word Password to Open Original file 

WPOM = MS Word Password to Open Modified file 

/WPOTO{Password} 

/WPOTM{Password} 
WPOO = MS Word Password to Open Template of Original file 

WPOM = MS Word Password to Open Template of Modified 

file 

/XPOO{Password} 

/XPOM{Password} 
XPOO = Excel Password to Open Original file 

XPOM = Excel Password to Open Modified file 

/??? Not here, ask us, we may be able to accommodate you.  

Support@SoftInterface.com 

All Command Line Switches 

 

 

mailto:Isupport@SoftInterface.com
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Command Line Examples - General 
Command Line Examples - General 

See  also: 

 Using The Command Line Interface  

Command Line Examples - Excel  

Below are samples to choose from.  Select an example that matches your needs closest 

and modify accordingly. 

:===================================================================== 

: Diff Doc. (WWW.SoftInterface.COM) 

: 

: Find the example closest to your needs and modify accordingly.  

: EXAMPLES 1 - 5, Text File Comparison 

:    EXAMPLE 1 (Compare 2 Files, Show Side by Side) 

:    EXAMPLE 2 (Compare 2 Files, Show All In One) 

:    EXAMPLE 3 (Compare 2 Files, Show All In One, Create HTML Report 

:                and give it a title, Exit when done) 

:    EXAMPLE 4 (Compare 2 Files, Create Text File Report 

:                Exit when done) 

:    EXAMPLE 5 (Compare 2 Files, Create CSV Report 

:                Exit when done) 

:    EXAMPLE 6 (Compare 2 PDF Files with password "gonefishing", show 

:                side-by-side, display status message after comparison) 

: 

: NOTE: For long file paths use double quotes,  

:       i.e. /L"D:\Long Path\A.XLS" 

: 

:===================================================================== 

 

:---------------------------------------------------------------------- 

:    EXAMPLE 1 (Compare 2 Files, Show Side By Side) 

: 

: Compare "D:\A\Aristotle.TXT" to "D:\A\Socrates.TXT": 

:                /M d:\a\Aristotle.TXT /S d:\a\Socrates.TXT 

: Create Log file D:\a\Compare.LOG:  /L D:\a\Compare.LOG 

:---------------------------------------------------------------------- 

 

DiffDoc  /M d:\a\Aristotle.TXT /S d:\a\Socrates.TXT /L D:\A\compare.LOG 

 

:---------------------------------------------------------------------- 

:    EXAMPLE 2 (Compare 2 Files, Show All In One) 

: 

: Compare "D:\A\Aristotle.DOC" to "D:\A\Socrates.DOC": 

:                /M d:\a\Aristotle.TXT /S d:\a\Socrates.TXT 

: Show All In One: /F1 

: Create Log file D:\a\Compare.LOG: /L D:\a\Compare.LOG 

:---------------------------------------------------------------------- 
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DiffDoc  /M d:\a\Aristotle.DOC /S d:\a\Socrates.DOC /F1 /L D:\A\compare.LOG 

 

:---------------------------------------------------------------------- 

:    EXAMPLE 3 (Compare 2 Files, Show All In One, Create HTML Report 

:                with a specific title, Exit when done) 

: 

: Compare "D:\A\Aristotle.DOC" to "D:\A\Socrates.DOC": 

:                /M d:\a\Aristotle.DOC /S d:\a\Socrates.DOC 

: Show All In One: /F1 

: Create HTML Report,file name "D:\a\Report.HTM" : /R1 /T D:\a\Report.HTM 

: Title the report: /7 "Greek Philosophers" 

: Open Report: /O 

: Create Log file D:\a\Compare.LOG:  /L D:\a\Compare.LOG 

: Exit when done: /X 

:---------------------------------------------------------------------- 

 

DiffDoc  /M d:\a\Aristotle.DOC /S d:\a\Socrates.DOC /F1 /R1 /T D:\a\Report.HTM /7 

"Greek Philosophers" /O /L D:\A\compare.LOG /X 

 

:---------------------------------------------------------------------- 

:    EXAMPLE 4 (Compare 2 Files, Create Text File Report 

:                Exit when done) 

: 

: Compare "D:\A\Aristotle.DOC" to "D:\A\Socrates.DOC": 

:                /M d:\a\Aristotle.DOC /S d:\a\Socrates.DOC 

: Show All In One: /F1 

: Create HTML Report,file name "D:\a\Report.TXT" : /R2 /T D:\a\Report.TXT 

: Open Report: /O 

: Create Log file D:\a\Compare.LOG:  /L D:\a\Compare.LOG 

: Exit when done: /X 

:---------------------------------------------------------------------- 

 

DiffDoc  /M d:\a\Aristotle.DOC /S d:\a\Socrates.DOC /F1 /R2 /T D:\a\Report.TXT /O /L 

D:\A\compare.LOG /X 

 

:---------------------------------------------------------------------- 

:    EXAMPLE 5 (Compare 2 Files, Create CSV Report 

:                Exit when done) 

: 

: Compare "D:\A\Aristotle.DOC" to "D:\A\Socrates.DOC": 

:                /M d:\a\Aristotle.DOC /S d:\a\Socrates.DOC 

: Show All In One: /F1 

: Create HTML Report,file name "D:\a\Report.CSV" : /R2 /T D:\a\Report.CSV 

: Open Report: /O 

: Create Log file D:\a\Compare.LOG:  /L D:\a\Compare.LOG 

: Exit when done: /X 
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:---------------------------------------------------------------------- 

 

DiffDoc  /M d:\a\Aristotle.DOC /S d:\a\Socrates.DOC /F1 /R3 /T D:\a\Report.CSV /O /L 

D:\A\compare.LOG /X 

 

:---------------------------------------------------------------------- 

:    EXAMPLE 6 (Compare 2 PDF Files with password "gonefishing", show 

:                side-by-side) 

: Compare "C:\MyDocuments\FirstFile.PDF" to 

:         "C:\MyDocuments\SecondFile.PDF" 

: Show side-by-side:  \F2  

: Display status message:  \V 

:---------------------------------------------------------------------- 

 

DiffDoc  /M "C:\MyDocuments\FirstFile.PDF" /S "C:\MyDocuments\SecondFile.PDF" /8  

gonefishing /F2 /V 
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Command Line Examples - Excel 
Command Line Examples - Excel 

See  also: 

 Using The Command Line Interface  

 Command Line Examples - General  

 

Below are samples to choose from.  Select one that matches your needs closest and 

modify accordingly. 

 

:===================================================================== 

: 'Diff Doc' (DiffDoc) Excel Example Batch File. (WWW.SoftInterface.COM) 

: 

: Find the example closest to your needs and modify accordingly.  

: EXAMPLES 1 - 3, Excel File Comparison 

:    EXAMPLE 1 (Compare 2 Excel spreadsheets) 

:    EXAMPLE 2 (Compare 2 Excel spreadsheets, Specify sheet numbers) 

:    EXAMPLE 3 (Compare 2 Excel spreadsheets, Specify sheet numbers, rows and 

columns) 

: 

: EXAMPLES A - C, Report Creation 

:    EXAMPLE A (Compare 2 Excel spreadsheets, create Report (HTML, All In One) 

:                Exit when done 

:    EXAMPLE B (Compare 2 Excel spreadsheets, create Report (TXT) 

:                Exit when done 

:    EXAMPLE C (Compare 2 Excel spreadsheets, create Report (CSV) 

:                Exit when done 

: 

: NOTE: For long file paths use double quotes,  

:       i.e. /L"D:\Long Path\A.XLS" 

: 

:===================================================================== 

 

:---------------------------------------------------------------------- 

:    EXAMPLE 1 (Compare 2 Excel spreadsheets) 

: 

: Compare "D:\A\Descarte.XLS" to "D:\A\Plato.XLS": /M d:\a\Descarte.xls /S 

d:\a\Plato.xls 

: Create Log file D:\A\Compare.LOG: /L D:\A\Compare.log 

: 

:---------------------------------------------------------------------- 

 

DiffDoc /M d:\a\Descarte.xls /S d:\a\Plato.xls /L D:\A\compare.log 

 

 

:---------------------------------------------------------------------- 

:    EXAMPLE 2 (Compare 2 Excel spreadsheets, Specify sheet numbers) 

: 
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: Compare "D:\A\Descarte.XLS" to "D:\A\Plato.XLS": /M d:\a\Descarte.xls /S 

d:\a\Plato.xls 

: Create Log file D:\A\Compare.LOG: /L D:\A\Compare.log 

: Specify 2nd Sheet for both Original and Modified files: /Y2 /Z2 

: 

:---------------------------------------------------------------------- 

 

DiffDoc /M d:\a\Descarte.xls /S d:\a\Plato.xls /L D:\A\compare.log /Y2 /Z2 

 

 

:---------------------------------------------------------------------- 

:    EXAMPLE 3 (Compare 2 Excel spreadsheets, Specify sheet numbers, rows and 

columns) 

: 

: Compare "D:\A\Descarte.XLS" to "D:\A\Plato.XLS": /M d:\a\Descarte.xls /S 

d:\a\Plato.xls 

: Create Log file D:\A\Compare.LOG: /L D:\A\Compare.log 

: Specify 2nd Sheet for both Original and Modified files: /Y2 /Z2 

: Specify Rows 12-28 for both Original and Modified files:  /1 12-24 /3 12-24  

: 

:---------------------------------------------------------------------- 

 

DiffDoc /M d:\a\Descarte.xls /S d:\a\Plato.xls /L D:\A\compare.log /Y2 /Z2 /1 12-24 

/3 12-24 

 

:---------------------------------------------------------------------- 

:    EXAMPLE A (Compare 2 Excel spreadsheets, create Report (HTML, All In One) 

:                Exit when done 

: 

: Compare "D:\A\Descarte.XLS" to "D:\A\Plato.XLS": /M d:\a\Descarte.xls /S 

d:\a\Plato.xls 

: Create Log file D:\A\Compare.LOG: /L D:\A\Compare.log 

: Create report to target file "D:\A\Report.HTM": /T D:\A\Report.HTM 

: Specify HTML Report format: /R1 

: Specify All In One style: /F1  

: Open Report, exit when done: /O /X  

: 

:---------------------------------------------------------------------- 

 

DiffDoc /M d:\a\Descarte.xls /S d:\a\Plato.xls /L D:\A\compare.log /T 

D:\A\Report.HTM  /R1 /F1 /O /X 

 

:---------------------------------------------------------------------- 

:    EXAMPLE B (Compare 2 Excel spreadsheets, create Report (TXT) 

:                Exit when done 

: 

: Compare "D:\A\Descarte.XLS" to "D:\A\Plato.XLS": /M d:\a\Descarte.xls /S 

d:\a\Plato.xls 

: Create Log file D:\A\Compare.LOG: /L D:\A\Compare.log 
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: Create report to target file "D:\A\Report.TXT": /T D:\A\Report.TXT 

: Specify TXT Report format: /R2 

: Open Report, exit when done: /O /X  

: 

:---------------------------------------------------------------------- 

 

DiffDoc /M d:\a\Descarte.xls /S d:\a\Plato.xls /L D:\A\compare.log /T 

D:\A\Report.TXT  /R2 /O /X 

 

:---------------------------------------------------------------------- 

:    EXAMPLE C (Compare 2 Excel spreadsheets, create Report (CSV) 

:                Exit when done 

: 

: Compare "D:\A\Descarte.XLS" to "D:\A\Plato.XLS": /M d:\a\Descarte.xls /S 

d:\a\Plato.xls 

: Create Log file D:\A\Compare.LOG: /L D:\A\Compare.log 

: Create report to target file "D:\A\Report.CSV": /T D:\A\Report.CSV 

: Specify CSV Report format: /R3 

: Open Report, exit when done: /O /X  

: 

:---------------------------------------------------------------------- 

 

DiffDoc /M d:\a\Descarte.xls /S d:\a\Plato.xls /L D:\A\compare.log /T 

D:\A\Report.CSV  /R3 /O /X 
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What You Will Need To Use 'Diff Doc' 
What You Will Need To Use 'Diff Doc' 

The minimum hardware and software requirements to install and support the use 

of ‘Diff Doc’ are: 

 IBM or compatible PC/AT (Pentium or higher CPU) with 16 MB of 

memory and one hard disk drive with 3 MB of space 

 VGA or SVGA display adapter 

 Any 32 bit Windows Operating System (including: Microsoft Windows 95, 

Windows 98, Windows 2000, Windows XP) 

 If comparing MS Word documents you will need MS Word 
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Installing 
Installing 

When you run the setup program to install on your computer, you will be able to 

specify where on your hard drive to install.  It is preferred to install it in the 

suggested directory for consistency (although not required). 

Run the Setup.EXE that came with the ‘Diff Doc’ media.  You may do this by 

clicking the Start button from the taskbar and select the Run... menu option.  

Then type the path and location of the Setup.EXE program.  For example: 

   

A:setup 

   

Then press ENTER and follow the installation instructions on the screen.  
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Uninstalling 
Uninstalling 

It is highly suggested that you uninstall before upgrading to a newer version of 

the product. 

To uninstall click the Start button from the taskbar and select Settings then 

Control Panel.   

   

 

Within the control panel select the Add/Remove Programs icon.  Double click on 

the 'Diff Doc' entry in the list box or push the Add/Remove button to uninstall. 

   

All files copied during the installation will be removed (only if other programs 

are not currently dependent on them).  Furthermore, if files have been added to 

the installation directory (i.e. program files you created) then the uninstall wizard 

will report that not all directories could be deleted.  You will have to manually 

remove these files. 
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Appendix A Sample Reports 
Sample Report-Text Comparison (All In One) 

 

'Diff Doc' Results 

Date and Time:3/5/2005 1:53:03 PM 

Original File: D:\Delme\1\md_master.TXT 

Modified File: D:\Delme\2\md_source.TXT 

Compare File Results:  

3 Change Found 

0 Addition Found 

0 Deletion Found 

 # 
[Original] D:\Delme\1\md_master.TXT <------------> [Modified] 

D:\Delme\2\md_source.TXT  # 

1  Dear Friend  1  

2    2  

3  
'Diff Doc' now compares paragraphs with VERY great detail. So many people demanded 
this feature dat that we DEFINITELY had to put it in. Keep the great feedback coming so 
we can continue to deliver quality products!   

3  

4    4  

5  
Also: CompareFilesX has now added a "synchronous" file compare routine, eliminating the 
need to use a separate thread.  

5  

6    6  

7  And Finally: WordConvererX now as a DLL interface.  7  

8    8  

9  Please go to our website to try our latest software.  9  

10    10  

11  Best Reg ards, Regards,   11  

12    12  

13  Allen Segall  13  

14  (SoftInterface, Inc.)  14  

15  WWW.SoftInterface.COMM WWW.SoftInterface.COM   15  

16  "Don't Face the Soft Facts of Life Alone"  16  

 

 

Sample Report-Text Comparison (Side By Side) 
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'Diff Doc' Results 

Date and Time:1/25/2005 6:42:05 PM 

Original File: D:\Delme\1\md_master.TXT 

Modified File: D:\Delme\2\md_source.TXT 

Compare File Results:  

10 Line Changes Found 

1 Line Additions Found 

1 Line Deletions Found 

 # [Original] D:\Delme\1\md_master.TXT  [Modified] D:\Delme\2\md_source.TXT # 

1  Product Information Form  Product Information Form  1  

2      2  

3  
Please enter the following information as 
you wish it to be presented on our site:  

Please enter the following information as 
you wish it to be presented on our site:  

3  

4      4  

5  Program Name: FindInFilesX Pro   Program Name: FindInFilesX Pro   5  

6      6  

7  Release date: 12/1/2000  Release date: 12/1/2000  7  

8      8  

9  Your SKU/Part number: 2001  Your SKU/Part number: 2001  9  

10      10  

11  
Platform(s) that program is compatible with: 
All 32 bit OCX Hosting Development 
Environments  

Platform(s) that program is compatible with: 
All 32 bit OCX Hosting Development 
Environments  

11  

12      12  

13  Language Version: N/A  Language Version: N/A  13  

14      14  

15  
System Requirements: 32 bit Operating 
System, 32 bit development environment  

System Requirements: 32 bit Operating 
System, 32 bit development environment  

15  

16      16  

17  

Long product description (Max. 250 words): 
FindInFilesX, grep, is designed to assist 
developers to quickly add a text search 
utility to their end products. The parsing of 
files for text is encountered often in all 
areas of software programming. A key 
feature of this OCX is that it runs on a 
separate thread allowing the end users 
application to continue functioning in a 
responsive manner.   

Long product description (Max. 250 words): 
FindInFilesX, grep, is designed to assist 
developers to quickly add a text search 
utility to ther end products. The parsing of 
files for text is encountered often in all 
areas of software programming. A key 
feature of this OCX is that it runs on a 
separate thread allowing the end users 
application to continue work in a responsive 
manner.   

17  

18      18  
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19  
FindInFilesX encapsulates all details 
required for quick integration.   

FindInFilesX encapsulates all details 
required for quick integration.   

19  

20      20  

21  LONGER DESCRIPTION:  LONGER DESCRIPTION:  21  

22  

FindInFilesX, grep, is designed to assist 
developers to quickly add a text search 
utility to their end products. The parsing of 
files for text is encountered often in all 
areas of software programming. 

FindInFilesX, grep, is designed to assist 
developers to quickly add a text search 
utility to their end products. The parsing of 
files for taaaext is encountered often in all 
areas of software programming. 

22  

23  Pro vs. Standard Feature Differences  Pro vs. Standard Feature Differences  23  

24  FEATURE   FEATURE   24  

25  STANDARD   STANDARD   25  

26  PROFESSIONAL   PROFESSIONAL   26  

27  Regular Expression  Regular Expression  27  

28  Not implemented  Not implemented  28  

29  Implemented  Implemented  29  

30  Parsing Speed  Parsing Speed  30  

31  Standard  Standard  31  

32  3x Standard  3x Standard  32  

33  Built In GUI  Built In GUI  33  

34  
Output Display of results dialog, and the 
FindInFilesOptions dialog are built in.  

Output Display of results dialog, and the 
FindInFilesOptions dialog are built in.  

34  

35  
None. Visual Basic source code for the 
demonstration program is provided 
however.  

None. Visual Basic source code for the 
demonstration program is provided 
however.  

35  

36  
Search Engines separate thread of 
execution  

Search Engines separate thread of 
execution  

36  

37  Out of process server  Out of process server  37  

38  
Thread launched within containing 
application  

Thread launched within containing 
application  

38  

39  
Persistence of Search Options and 
Attributes  

Persistence of Search Options and 
Attributes  

39  

40  All options and attributes are persistent  All options and attributes are persistent  40  

41  Only Boolean options are persistent.   Only Boolean options are persistent.   41  

42  Language used to create component  Language used to create component  42  

43  Microsoft Visual Basic  Microsoft Visual Basic  43  

44  Microsoft Visual C++  Microsoft Visual C++  44  

45      45  

46  

Short product description (Max. 15 words): 
FindInFilesX is designed to assist 
developers to quickly add a text search 
utility to their end products.  

Short product description (Max. 15 words): 
FindInFilesX is designed to assist 
developers to quickly add a text search 
utility to their end products.  

46  

47      47  
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48  
Special instructions for customer: Check 
WWW.SoftInterface.COM for latest 
releaese information.  

Special instructions for customer: Check 
WWW.SoftInterface.COM for latest 
releaese information.  

48  

49  (These will be sent to the customer in their) (These will be sent to the customer in their) 49  

50      50  

51  

Key words for our Search Engine: Grep, 
Find,Text, Sort, File, Case, Sensitive, 
Parse, Visual, Basic, OCX,ActiveX, 
FindInFilesX, SoftInterface  

Key words for our Search Engine: Grep, 
Find,Text, Sort, File, Case, Sensitive, 
Parse, Visual, Basic, OCX,ActiveX, 
FindInFilesX, SoftInterface  

51  

52  

(Max. 15 unique words, each word comma 
separated. Words that are separated by a 
space indicated separate words - ex. "Anti 
Virus" should be "anti, virus")  

(Max. 15 unique words, each word comma 
separated. Words that are separated by a 
space indicated separate words - ex. "Anti 
Virus" should be "anti, virus")  

52  

53      53  

54  
Categories: Component, Tool, ActiveX, 
Utility, Text, Editor  

Categories: Component, Tool, ActiveX, 
Utility, Text, Editor  

54  

55      55  

56  Program file: FiFx Latest Release.ZIP  Program file: FiFx Latest Release.ZIP  56  

57  

(This is the file the customer will down load. 
A self-extracting .exe or .bin file if a Mac 
product. File name should be alpha 
numeric only with no spaces, it is also 
recommended to use a unique file name 
that has some reference to product, version 
& language - ex. (abc2eng.exe)   

(This is the file the customer will down load. 
A self-extracting .exe or .bin file if a Mac 
product. File name should be alpha 
numeric only with no spaces, it is also 
recommended to use a unique file name 
that has some reference to product, version 
& langbbbbuage - ex. (abc2eng.exe)   

57  

58      58  

59  License Agreement (EULA): See Bottom  License Agreement (EULA): See Bottom  59  

60  
(If no EULA is supplied, Buyonet will 
provide the customer with a general EULA)  

(If no EULA is supplied, Buyonet will 
provide the customer with a general EULA)  

60  

61      61  

62  Picture file (gif or jpg format):   Picture file (gif or jpg format):   62  

63  
(Displayed next to the description of the 
product,logo)  

(Displayed aside to the description of the 
product logo)  

63  

64      64  

    THIS LINE WAS ADDED   65  

65  Screen Shots picture file (up to 4):   Screen Shots picture file (up to 4):   66  

66      67  

67      68  

68      69  

69      70  

70      71  

71      72  

72      73  

73  (recommended size 640 x 480 - also .gif or (recommended size 640 x 480 - also .gif or 74  
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.jpg format)   .jpgccformat)   

74      75  

75  Type of release: New Product   Type of release: New Product.   76  

76  (new product, upgrade, bug fix, etc...)  (new product, upgrade, bug fix, etc...)  77  

77      78  

78  Old version(s) to be removed from the site:  Old version(s) to be removed from the site:  79  

79      80  

80  Territory restrictions:  Territory restrictions:  81  

81  
(countries where the product cannot be 
sold)  

(countries where the product cannot be 
sold)  

82  

82      83  

83  Software License and Software Disclaimer Software License and Software Disclaimer  84  

84  

This a legal document which is an 
agreement between you, the Licensee, and 
SoftInterface, Inc.. By opening/installing the 
software, Licensee agrees to become 
bound by the terms of this agreement, 
which include the Software License and 
Software Disclaimer of Warranty.   

    

85  License  License  85  

86  

This software, (herein after "Software") is 
owned by SoftInterface, Inc., which 
reserves all rights not granted to you by this 
Agreement. .  

This software, (herein after "Software") is 
owned by SoftInterface, Inc., which 
reserves all rights not granted to you by this 
Agreement 

86  

87      87  

88  You May:  You May:  88  

89  

1. Use the Software on only one computer 
by one user at a time, even if the Software 
is distributed in more than one disk size or 
format  The Software is in "use" on a 
computer when it is loaded into temporary 
memory (i.e. RAM) or installed into 
permanent memory (e.g. hard disk, or other 
storage device) of that machine.   

1. Use the Software on only one computer 
by one user at a time, even if the Software 
is distributed in more than one disk size or 
format  The Software is in "use" on a 
computer when it is loaded into temporary 
memory (i.e. RAM) or installed into 
permanent memory (e.g. hard disk, or other 
storage device) of that computer.   

89  

90  2. Make one backup copy of the software.  2. Make one backup copy of the software.  90  
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Appendix B Troubleshooting 
Appendix B Troubleshooting 

The SoftInterface, Inc. web site (www.SoftInterface.COM) will have the latest 

information for ‘Diff Doc’.  We suggest the following sequence to troubleshoot: 

 Review this manual 

 Bug list and Frequently Asked Questions (FAQ) 

(http://www.softinterface.com/md/md_faq.htm) 

 Latest Patches/Downloads, see the Revision History page 

(http://www.softinterface.com/MD/MD_RevHistory.htm) 

Finally, if you still have trouble you may e-mail for support at 

Support@SoftInterface.COM. 

 

http://www.softinterface.com/
http://www.softinterface.com/md/md_faq.htm
http://www.softinterface.com/MD/MD_RevHistory.htm
mailto:Support@SoftInterface.COM
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Appendix C Using the Explorer Shell 
Appendix C Using the Explorer Shell for Quick Comparisons 

You can call up the Explorer Shell context menu by right clicking directly on a 

file document or folder you would like to compare.  To compare files select 

'Compare with Diff Doc' followed by 'Set as Original File'.   

 

Next right click on the document you'd like to compare against the original.  

Again select 'Compare with Diff Doc' and another submenu appears letting you 

see which two documents you'll be comparing.  You can either go ahead with the 

comparison or set the current document as the new original.  Diff Doc launches 

with the two desired documents and displays the results of the comparison. 

File Compare Options are available through the context menu.  By checking or 

unchecking you can set all-in-one or side-by-side comparisons, as well as options 

to ignore case, white space and/or empty lines. 

 

 

The Explorer Shell context menu works exactly the same for folders.  Just right 

click on a folder to bring up the menu, select 'Compare with Diff Doc'.  The 

submenu will display 'Set as Original Folder'.  Right click on a second folder to 

generate the following menu: 

 

Select the first option 'Compare [folder name] to [folder name] 

Note that there is one option available under 'Folder Compare Options' that 

allows you to include subfolders. 

 

The Explorer Shell context menu is also available from the desktop by right 

clicking on a specific document.  Additionally, you can launch a Diff Doc 

comparison by right clicking on a file name or folder from within Explorer 

search results. 
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Note:  Whether comparing files or folders, Diff Doc makes available a list of 

your most recent comparisons under the 'Recent Compares' menu item.  You can 

rerun any one of them simply by clicking on it. 
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